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Welcome to Winlive 7.0 Professional Edition 

 

 

INTRODUCTION 

 

Winlive Pro Synth 

Thank you for choosing Winlive, the first Karaoke software in Italy. 

Winlive’s Pro version was conceived for professional usage, and with its latest update, it 

became one of the most appreciated versions of the software even among singers and 

entertainers who request a solid program with excellent karaoke, compatibility and 

versatility functions.  

The Pro version is one of the commercial versions of Winlive, therefore disposal to others, 

illegitimate copy of the license and any other hacking action concerning the software are 

forbidden. 

The implementation of Reverse Engineering, the amendment of the code and graphic 

resources and the reproduction, even in part, of all files are forbidden and could be liable 

to prosecution. 

All responsibility for improper use of the program and/or damages to the operating system 

and loss of data is disclaimed. 

For more information go on our website: 

 www.promusicsoftware.com 

 

Pro Music Software reserves its rights on the Winlive brand. 
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Installation and requirements 

To install Winlive, perform setup and follow the instructions on screen. 

After installation, the program usually starts automatically, requiring a license number. 

Demo mode can be chosen if you do not have a license. 

If you have a Serial Number and a Personal Account, you can insert them and request a 

license by clicking on the drawn up link in Winlive. You can activate Winlive from another 

computer through the “Winlive Activations - On Line Licenses” section on our website 

www.promusicsoftware.com 

 

Winlive Pro needs the following requirements: 

Minimum configuration: 

-Windows Vista, Windows 7, 8, 8.1 and Windows 10 32/64 bit 

-160 MB of free storage on HD 

-Direct X 9.0c or more recent 

-Compatible Windows sound card  

-1024x600 resolution video card 

-At least 1 Gb of Ram memory (2 Gb Windows 7 or superior) recommended 

-CD-Rom player or setup download 

 

NB: the minimum configuration shall ensure the proper functioning and performance of music tracks on 

behalf of the program but you might need to disable graphic effects for a better quality, which might lower 

significantly during the reproduction of  CDG and VIDEO files. 

 

The software could work even on older versions of Windows but a correct functioning is 

not guaranteed. 

*with a minimum configuration, starting the program could be slower due to the swapping on your HD and the sluggishness of the 

processor. 

*Some antivirus softwares could slow up the start of the program. If it stops for too long go on “check Antivirus” and disable it 

temporarily. 

 

 

Functionalities 

Winlive Pro 7 is a Karaoke software as well as a MIDI, KAR, MP3, CDG, WAV, RTF, JPG, 

BMP, GIF, MPG, AVI*, TXT, FLV*, MP4*,YTB* player. 

Through the software, it is possible to manage the reproduction of the above-mentioned 

files in real time, by visualizing in a very clear and simple way all lyrics possibly contained 
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and synchronized into the files. It is possible to synchronize lyrics and chords on files 

which contain none.  

Winlive Pro can manage a maximum of 42 playlists, called “Song Lists”, 39 of which are 

stored in its Database, 1 is temporary (F10) and 2 are unprecedented Song Folder Lists 

(F11 and F12). 

It is possible to control various parameters of a music file from start and stop, tempo and 

key changes (on any audio format), instruments, volumes, pan, etc…to every single beat 

of the drums, all in real time! 

 

*The reproduction of certain Video files requires the installation of appropriate codecs. 
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Instructions for usage 

 

General description 

When launching Winlive, it is possible to select the operating mode for the program 

through the View menu 

 

“Performance Mode” is the reproduction manner by which you can control song lists, book 

songs and check the whole performance, mixer and karaoke; 

 

“Database Mode” is the songs’ programming manner. 

The database keeps track of the path of the songs, their parameters, changes and 

disposition of possible background pictures or associated lyrics; 

 

The “Online Backing tracks” mode allows you to view catalogues and perform online backing tracks;  

“Edit  mode” is the manner by which it is possible to edit songs parameters, lyrics, chords 

and locators; 

 

“Media Explorer  mode” is the manner by which it is possible to explore hard disks and 

reproduce files, without having to insert them into the database. 

 

“Winlive DJ Control  mode”  with BPM recognition for Audio files with real time effects. 

 

“Metrodrummer“ ( electro drums with pre-set rhythms ) with Midi files synchro possibility. 

Background playlists / background songs 

 

Winlive is therefore geared to immediacy during your performance of music tracks which 

can be recalled by simply selecting their list of belonging through function, selection and 

enter keys.  

The main task for the musician will be inserting tracks into the database, changing their 

key, volumes or exclude tracks as appropriate and possibly listen to their previews. 

Moreover, the functionalities of the professional version allow lyrics, chords and locators to 

be inserted and make varying musical instruments by controlling all parameters possible.  
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Once on stage, those settings will forever remain virtually saved and you will only need to 

play songs in order to sing to your files and karaokes with your pre-set parameters. It is 

possible to enter Database mode via Database/database menu. By shutting Database 

down, you will go back to Performance mode.
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This new version of Winlive includes the possibility to arbitrarily select files from the hard 

disk by clicking on the File/Load File menu or by recalling Load File by right clicking on the 

Karaoke screen.  

There also is a possibility of setting two different folders, callable by clicking on F11 and 

F12 (Song Folder List) from which to dip in all their contained files, provided that they are 

Midi, Kar, Mp3, Cdg, Wav, Mpg, Avi, Mp4, Flv, Txt, Rtf, Jpg, Bmp, Ytb, and Gif files. 
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Performance Mode 

 

The following image represents the “Performance mode” screen from Winlive Pro 7.0 

 

 

 

 

Song list 

The song list is the “heart of the program” accessible through all function keys or  

The grid will show the song’s title (as set into the database) and typology, namely the file 

type among MIDI, KAR, MP3, WAV, MPG, AVI, MP4, YTB, FLV, TXT, RTF, JPG, BMP, 

GIF,  highlighted by a well-defined and recognizable color. 

Tracks containing lyrics are characterized by  icon. 

Selection can happen through cursor keys (commonly called arrows) on the keyboard or 

through the mouse. 

The song lists (or playlists) are 39 in total and can be called off by using the following keys: 

 from F1 to F9 

 Shift + [ from F1 to F10 ] 

 Ctrl + [ from F1 to F10 ] 

 Shift + Ctrl + [from F1 to F10 ] 
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It is also possible to set some special song lists:  

-F10 (temporary song list) it is possible to add tracks from the other song lists by pushing 

‘INS’ or right clicking and then ‘add to F10’ 

-F11, F12 (song folder lists) it is possible to add all files from a folder to one of the two 

lists, to set the folder, press ‘\’ on the keyboard or  

The combination of Shift + F11 or Shift + F12 on the keyboard allows you to view the 

whole database in one big song list. 

The BACKSPACE  key or  launches the search bar (following image) 

 

Barra di ricerca 

 

 
 

Song List 

 

Suggestions: 

1) It is possible to scroll down on your search on different occurrences of your song list by pressing the 

“TAB” key on the keyboard. For example, a search for “CIAO” will send back to “Ciao mare”, “O bella ciao”, 

etc… 

 2) If authors and singers are set in the database, we can filter the playlist and only view determined authors 

or singers. Click on “TUTTI/ALL” to view the original song list again. 

3) It is now possible to search the whole database  by simply clicking on “Shift+F11” or “Shift+F12” from the 

keyboard. 
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Menu Popup 

 

 

 

It is possible to start a Popup Menu by right clicking on the main screen of Winlive, from 

which you can access many different functionalities. 

 

 Load File: it allows you to read files on the spot, without inserting them into the 

database; 

 Save File: save file physically (see dedicated section); 

 Generate Songbook (lyrics and chords) : it opens a .txt file to insert lyrics and chords; 

 Folder: rapid access to Song Folder Lists; 

 Fullscreen: view the main screen on full screen; 

 Normal: it restores the menu and control bar view; 

 Minimize: the Performance image iconifies; 

 Window dimension: it allows to reduce the dimension of the window; 

 Karaoke Mode: it allows to choose different modes, like Classic (2 lines), Modern (4 

lines), Reading (2 pages), Music stand with chords; 

 Enhance Font: it allows to enlarge font size; 

 Font: it allows to change font type, style and dimensions; 
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 Karaoke Monitor: it allows you to activate second monitor (see dedicated section); 

 Karaoke Monitor Mode : it allows you to choose the view mode of the monitor and the 

font size 

 Clone Monitor; it activates and deactivates a clone monitor of the main one; 

 Do not insert in ‘SIAE’ list; 

 Keyboard Lock (CTRL+S): keys are deactivated when using this option; keyboard 

starts working again by pressing a function key 

 Stop-Panic: it stops playing files and re-initializes the expander; 

 Import in database: it imports a track directly in database. 
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Control Bar 

 

 

The bar is divided in three parts, the left part is reserved for the song playing at the 

moment (Main Song), the part in the middle is reserved for the booked song. 

The third part is composed of a series of rapid access keys for the various functions and 

modes in Winlive 7. 

Through the keys at the bottom, it is possible to control: 

 

The melody channel (on or off) for midis; 

The BPM tempo compared to the original tempo for midis; 

The key for midi as well as for audios and videos. 

 

Once you set your personalized tempo and key (even for volume and other parameters 

you can check from Mixer – see dedicated section), it is possible to virtually save these 

parameters on database, by pressing . 

 

By clicking on Title or Singer, you can access the Quick Edit  functionality. 

 

 

 

This function allows to quick edit Title, Singer, Author and to change the belonging Song 

List of the track. 

Via the  key, it is possible to quickly localize the file on the Hard Disk. 
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With the  key, you can erase the file from the database. 

 

By clicking twice on  it is possible to choose whether the instrumental has Karaoke or 

not. 

 

 

 

 

On the right side of the bar, you can notice many colorful buttons which allow rapid access 

to the various modes and functions: 

 PRF: speed dial to come back to Performance mode; 

 EXP: speed dial to enter Media Explorer mode; 

 MDR: speed dial to open Metrodrummer (Virtual Drum Machine); 

 WDJ: speed dial to access Winlive DJ Control; 

 CDP: speed dial to enter CD Player; 

 BKG: speed dial to access Background Songs; 

 KMN: access to the Karaoke Monitor; 

 DBS: access to the database; 

 EDT: Access  to Edit Mode; 

 MDB: Melody Bar opening; 

 PNO: Piano Key Board opening; 

 CHD: Chord Bar opening;
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Locators 

Locators allow you to quickly access various sections in a song. 

To register them, you need to enter Edit mode (see dedicated chapter). 

When one of the locators is set as starting locator, the background to the locator’s 

corresponding key turns blue; instead when one of the locators is set as final locator, the 

background turns green. 

Setting starting locators can be useful, for example, for skipping the introduction to the 

song and going directly to its verse. 

It is possible to quickly access locators by clicking on the key corresponding to the locator 

with your mouse or via the speed dial keys. 

 

Pre-Listening 

To use this functionality correctly you got to have a second audio interface (see Option 

chapter). You can access it by clicking on  after booking an audio song (MP3 or 

WAV). 

 

 

With the Set(J) key, you can set the starting point to a song, and with the Test(H) key it is 

possible to preview the song starting from the set point. With the transport key, you can 

edit the starting point precisely. Moreover, it is consented to set the volume of the song 

through the Gain bar. Once you finish pre-listening, you can quit by saving your edits with 

the  key, or quitting and canceling by clicking on . 

When the performing song finishes ,or gets mixing(y), fading out(q) or immediate start 

(enter), the booked song will star from the point set during pre-listening. 
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Karaoke Monitor 

You can activate Karaoke Monitor by clicking on the “View” menu -> “Karaoke Monitor” or 

CTRL+K  from keyboard. 

A second Winlive window will be opened and you will be able of dragging it on the second 

monitor; by double clicking on the window, it will be set on full screen. 

By right clicking on the screen of the main monitor, it is possible to edit font and mode of 

the Karaoke  Monitor. You can choose among: 

 WinLive Classic: 2 lines; 

 Modern Style: 4 lines. 

 Music stand mode: 4 lines + 1; 

 Karaoke  Zoom mode. 

 

NB: in order for this functionality to work correctly, you have to set your second monitor in Full Desktop 

mode. Be referred to the video card manual. 

Melody Bar 

It gets activated and deactivated through the “View” menu -> Melody Bar or by speed 

dialing MBD or E. 

The window will be visualized by just pressing once and it describes chords ( if available 

with the backing track) and melody notes. Clicking on it twice allows you to only view the 

graphics of the development and the timing of the melody (track 4 if midi, based on lyrics if 

mp3), in order to help the singer follow the beat. This functionality is very useful for 

karaoke 
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nights.

 

It is possible to set a steady melody bar or a sliding one (see option chapter). 

 

If it were set steady, page change would happen in correspondence to the red line at the 

bottom (usually every 40 seconds). 
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Chord Bar 

It gets activated via “View” -> “Chord Bar” or by speed dialing “C”. 

 

It shows chords (if available), by making them slide while playing the song. 
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Suggestions: 

IT IS POSSIBLE TO VIEW CHORDS OVER LYRICS BY CHOOSING KARAOKE -> MUSIC STAND WITH 

CHORDS AS VIEW MODE. 
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Mixer 

To select muted channels, you need to open the mixer ('X' key) or click on . 

The Mixer window positioned on the left side of the Performance view permits to keep 

.various midi and audio parameters under control. 

     

Click on an option to open a drop-down menu and make 

a choice, like enabling/disabling a track, Solo playing it or 

activating them all. You can also detailly see a track, 

Drum editing it and User Sound Editing it (see detail). 

In red  you have muted channels, in white the active 

ones. 

From this section, you can get to know the Time 

Signature (4/4, 3/4,12/8) etc, accordingly the metronome 

will go based on the tempo. You can enable/disable a 

metronome by clicking on the corresponding key. 

The Comp key activates and deactivates the 

compression of the midi files’ dynamics. 

Through the Device column,  you can select a different 

midi output for every single channel. You can apply these 

Device settings to all songs by clicking on Lock. 

In the Audio section you can find the volume Fader to 

regulate the levels of outgoing audio and three faders for 

sound equalization; Gain regulates the gain of the audio 

track; The V.Att fader regulates the attenuation of the 

voice. Master Track Effects ( A – B ) faders regulate the 

volume of the selected effects in the drop-down menu in 

the corresponding box. 

2nd Track Effects ( C – D ) regulate the volume of the 

effects selected from the drop-down menu in the 



 19

 

corresponding box of the second track; 

The MIDI section presents a volume fader to increase or 

decrease the above mentioned and faders to dose 

Reverb and Chorus levels in the MIDI track. 

The Drum Part Off section allows to exclude sounds from 

the drum’s part. 

 

 

The “Winlive Midi Cover” function allows you to choose 

one of the pre-set registers to variate the feeling and the 

style of a midi file, you have to try this absolutely! 

* The efficacy of this functionality changes according to the backing track.  
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Details  (in mixer, click on an instrument’s name) 

 

 

 

From this window, you can control in a detailed way the functions of a track, you can 

choose an instrument from a family sound, the Track, Volume, Pan, Chorus and Reverb 

(in the case of an expander), the Key (+/- 12 half tones), the activity and playing it “solo”. 

The “PC” initials identify the transmitted Program Change number. 

You can edit sounds by editing different parameters (it only works with an expander): 

- Tone: it increases or decreases resonance ; 

- CutOff: it increases or decreases cut off frequency; 

- Attack/Release/Decay: it regulates the enveloping of the sound, according to the 

following scheme: 
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The view, if Channel 10/Drums is selected, changes like this: 

 

 

This way, DrumKits will be displayed instead of sound families. 

It is possible, if using an outer sound driver generator, to choose a non standard DrumKit 

by visualizing its relative Program Change. 

You can create 4 desks with 8 sounds each; every sound can be edited by name, Program 

Change to send [0…127], the value of the Control Change [0…127] (it is possible to send 

CC#0 and/or CC#32, be referred to the expander’s guide) and at last, all the parameters 

which characterize the sound. 

For a preview, it is possible to click on the box at the left bottom or the left CTRL key. 

Once the desk is created, it needs to be saved by clicking on . Moreover, it is 

consented to export sound desks towards external files and import them again 

successively. 

This function is very useful if using an outer expander since you can create different 

personalized sounds, one for each expander. 

 

By clicking on “User Drum Kit” the screen changes like this: 
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By clicking on “User Sound Editing” you can create new sound desks. 

 

 

In this window, you can substitute each single drum sound on channel 10. The maximum 

number of editable sounds is 8 and you can also edit the intensity of the dynamics of each 

sound and previewing them by pressing . 

The little window at the bottom will display the names of all the drums instruments used by 

the current song, highlighting in yellow the edited ones. You can reset the original drums 

by clicking on Reset. 

The virtual saving allows  to memorize the change into the database. 

Keyboard  

This function, which enables by pressing “T” at the top right of the video in Performance,  

activates a virtual keyboard as shown in the following picture: 
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It allows to utilize basic commands if you’re using WINLIVE on a tablet or touch screen 

device.  

The F1 / F9,  Shift  F1 / F10,  Ctrl  F1 / F10,  Shift+Ctrl F1 / F10 keys select the song lists;  

Esc closes the list; 

The arrow keys on the left make the list slide in the selected direction; 

The +F10 and – F10 keys remove or add songs to the F10 contemporary list;  

Start allows the selected track to play; 

Mix allows to mix a song and the next one; 

The X key closes this function. 

 

Recording an audio track 

With this functionality you can record an audio track on a backing track from the DataBase, 

using its specific button. 

 

 

It is possible to select your preferred audio device from the panel. 

Line …………………….. 

Volume has a regulation fader of the input signal. 

Filename indicates the saving path of the recorded track but you can change it by dialing 

its specific key. 

WAV Format indicates the standard saving format  of the track but this can be changed as 

well through its specific key. 

By clicking on “Start Test” it is possible to make a recording test while checking the input 

volume level. At the end of the test, you can go back to the previous condition by clicking 

on “Stop Test”. 

 

Audio Sampler 

Through the  key, you can access the Audio Sampler, or trier. 



 24

 

 

With this sampler, you can reproduce sound effects on the spot, even while performing a 

song. 

You can have 10 desks by 10 samples each, for a total of 100 samples. 

To load these samples, you have to click on the box corresponding to each sample (when 

there is no loaded sample, “No Sample Loaded” appears) and choose files from the 

dialogue box. Wav and Mp3 files are supported. 
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You can set the volume for each sample.  It is possible to play sample in polyphony or, by 

checking the Mono option, playing them in Mono (if a sample is playing and you call off 

another one, the sample that is playing stops). 

Comp allows, if selected, to activate a general sound compressor on the samples, which 

standardizes their volume automatically. 

During a Performance, you can access the sampler by clicking on ‘S’, then you use keys 

from 1 to 0 . To force stop the reproduction of the samplers you got to press ‘\’ 

 

Song List Editor 

You can access the Song List Editor via the “Tools” menu. 

 

 

Through this functionality you can rename every single list: 

1 – by checking the STOP box, we want the list to stop playing at the end of every song, 

but if we do not check that box, songs from the list will play continuously; 

2 – By checking the MELODY box, every song from the list will be played without its 

melodic line; 

3 –ORDER  provides a drop down menu from which you can choose the reproduction 

order of the songs (if we select TITLE, for instance, we will get an alphabetical order, but 

you can sort by ID, by singer, by author and so on). 
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Mixing Editor 

You can access the Mixing Editor via the “Tools” menu. 

 

With the Mixing Editor you  can set the evolution and the length (in milliseconds) of the 

Cross-Fade, i.e. mixing two audio tracks. 

The green line indicates the song to end, whereas the red line indicates the booked line. 

Winlive will adopt a default linear behavior, with a constant and progressive reduction of 

the volume from the song to finish, together with a progressive and constant reduction of 

the volume from the booked song. You can select 5 pre-set curves or draw a personalized 

curve. 
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SIAE list 

Every played song (both in Performance Mode and on the spot) get memorized by Winlive. 

It is therefore possible to save this list as a text file. 

Select “Tools” menu -> “SIAE List”, the following window will be displayed: 

 

 

All SIAE lists are saved into the \SIAE * folder, available via Tools/SIAE List. 

 “Reset” erases all contents from a list. 

“Close” closes the function. 

With the “monitor” search key, you can look for the SIAE LIST’s files location. 

The drop down menu allows you to select when to save  a list: 1 – every time you quit the 

software; 2 – at the end of every song. 

 

* On Windows 7 and some versions of Windows Vista the \SIAE folder gets memorized in the virtual path, generally C:\Users\YOUR 

USERNAME\AppData\Local\VirtualStore\Program Files\WinLivePRO\SIAE 

The virtual path is accessible through Media Explorer mode (see dedicated chapter).
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Physical Song Saving 

You can access this via “Tools” -> “Save Song”. 

 

 

With this functionality you can save virtually or physically the edits made on MIDI files. 

By checking the “Save from first note” option, you get the possibility to cut out some 

seconds of silence which may be present at the beginning of a song. 

 

The “Output” column allows to change channel for every single track. 

 

I.G.: on some backing tracks, vocal melody is not saved on channel 4 (as foreseen into standards) but you 

can find it on other channels, for instance on channel 1. To invert tracks you will only need to write “4” in 

respect to channel 1, and “1” in respect to channel 4. 

 

The “Track” column permits to save or not the track  

The “Instrument” column indicates a changed instrument and saves it. 

The “Vol” column indicates whether a volume variation happened (100 = 100% off the 

original volume). 



 29

Moreover, you can choose to add lyrics or chords into the file. 

 

The “Add at the end” section allows you to add a number of seconds to the end of a song. 

It is possible to choose the track to edit and to insert lyrics and chords. 

With the   key, virtual edits get automatically saved onto the database, whereas the  

 keys are used to save midi files physically and to save all songs 

from F10 as MIDI. 

With the  keys, it is possible to convert a file from Midi to Wave 

and transform all songs  saved in F10 to Wave. 

The    key, allows you to change a midi file to Mp3 with the 

possibility to choose the sound quality of a file by clicking on an arrow key. 

 

NB: in the specific case of Mp3 files, only virtual saving is available. 
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Lyrics/Chords synchro   

You can access via “Tools” -> “Lyrics/Chords Synchro”. 

 

 

With this functionality, you can add Karaoke lyrics to Midi and Audio files. 

Lyrics get loaded by pasting them into the window or by opening a TXT file with the  

key. 

Through the  key, you can save lyrics as a TXT file, whereas you change all lyrics to 

capitals via  

With the “Import from Midi/Audio” option, you can import lyrics from an already written midi 

file or from an audio track but only if you are editing an audio. 

Synchronization can be made by line, word or syllable. 

To activate synchronization you need to click on “Start Synchro”. Then a backing track will 

start playing and, by clicking enter, according to the beat of the track, synchro will begin. 

You can also synchronize chords by checking the “Chords mode” box. 
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WinLive CD Player 

You can access it via “Tools” -> “Start WinLive CD Player” 

 

 

With this functionality, you can extract tracks from Audio CDs and save the mas Wav or 

Mp3. 

You need to select them (you can select them all via “All” or select them manually by 

checking on the first column), then click on Convert. 

You can choose among uncompressed Wav files (i.g. “Minimal Only for voice store” 

generates a low quality file for the smallest size, whereas “Maximum quality” generates a 

high quality file for a major file size). 

 

The peculiarity if this CD player is that it owns the same advanced functionalities as 

commercial CD players for DJs and it allows to edit tempo and key in real time. 
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Edit Mode 

 

Song Cue Points 

 

 

Using cue points allows skipping to different moments of the song in real time. For 

instance, you can associate cue point 1 to the first verse, cue point 2 to the chorus, cue 

point 3 to the second verse, etc…. 

The maximum number of cue points is 10 per song. 

 

There are many ways to register new cue points after playing a song: 

 press ALT +  [number from 1 to 0]; 

 or click on the cue point you want to register (or overwrite) in the box, then click on 

 

 or right click on the bottom bar 

 or with the ‘L’ key (it sorts them). 

 

To re position cue points: 

 select a cue point in the box, then reposition it by clicking on  and  

 or use ALT and + or ALT and – 

 or left click on the bottom bar and move it with the mouse. 

To remove a cue point you have to select it on the tab or on the bottom bar, then press 

CANC. 

 

You can rename cue point by double clicking on the tab. 

 

It is possible to use cue point to set a start and ending point to a song. 

For example, you can set cue point 1 on the first verse and skip intro and another cue 

point at the end of the second last verse, in order for the song to finish before the last 

verse. 
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These points can be edited with the keys you find at the right of your screen. 

 

Once you set your cue points, and your start and ending points, you need to click on Save. 

You can only save cue points if a file (Audio or Midi) was already imported into database. 

 

While performing a song, you can quickly recall cue points by clicking on the 

corresponding key. (see Option chapter). 

With the Shift + [number key] combination, switching towards a recalled cue point won’t 

happen immediately but the software will wait for the next measure in the song. 

 

If cue points are saved, they will be displayed in the next song bar. Therefore pressing on 

Control + [number key], or clicking on the cue point of the booked song, in Performance, 

will allow the next song to start from a chosen cue point. 

 

Midi Mixer 

Right after the cue points dedicated side, you can see a simplified version of the Mixer, 

valid for Midi files only. 

 

 

For every single channel, you can regulate volume, mute or change instrument (by clicking 

in the name of the instrument on the corresponding channel). 
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Karaoke Editor  

You can accessi t via .  

 

 

With this functionality you can edit in advanced mode karaoke lyrics. 

Shift – Slide allows to move all lyrics, forestalling or postponing them by a certain number 

of milliseconds, which you can see in correspondence. 

Collapse-Expand compresses or expands lyrics allocation. 

The   key capitalizes everything. 

The  key automatically optimizes lyrics by moving page changes to simplify reading 

while playing the song, moreover it removes empty double lines, by removing double page 

changes.  

The  key allows inserting new lyrics. 

With the “SAVE” button, all made changes get saved. 

 

Chord Editor 

Same as for Karaoke Editor, you can access Chord Editor to edit chords by clicking on 

. 
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Il Database 

 

Here is the ”Database“ screen from Winlive Pro 7.0 

 

 
 

-Create, open and save 

In Winlive Pro 7 you can access database by clicking on the top menu Database -> 

Database or from View -> Database. 

 

Winlive Pro 7 allows you to manage more than a Database. 

 To create a new database click on:   

Winlive will demand whether to save an already existing database then it will empty 

current database. 

 To open an existing database click on :  

Winlive will ask to specify the name of the database. 

 To save current database with a name go on:  

Winlive will ask to specify the name of the database to save. 

 To import a database created with versions 4.5 / 4.6 / 4.7 / 5.0 / 5.5 click:  

Winlive will ask to specify the name of database to open. 
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 To back a database up press on :  

 To back up a previously created database click on:  

Winlive will display time and date of the backup. 

 

Warning: creating a new database, or restoring a backup, will erase the new one if unsaved.  

 

-Editing cells 

you can modify cells’ values by double clicking on a cell if you are on “Selection” mode. 

Single click or enter key if you’re in “Edit” mode. 

On some fields, placing will be immediate, whereas on some others you can write directly. 

Other fields are just informative so editing them won’t be possible, for example field Type, 

ID… 

 

“ORDER” field allows you to create a customized list order. 

 

You can edit some values in a fast way by using “Preview”, from which you can also listen 

to a preview of the song with your applied settings. 

 

Right clicking on a cell (or on a selection of cells) allows you to access a menu through 

which you can edit a cell, sort by selected column, use file name as title, move song to 

another list, quickly rename according to file path, copy physical file into another folder, 

analyze files to look for more info, CAPITALIZE  title. 

-Multi-selection 

If you hold down CTRL you can select more songs to work with groups. 

If you are in “Selection” mode, a song get deselected by clicking on it, whereas in “Edit” 

mode you can deselect everything by clicking anywhere. 
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-songs import 

Songs can now be imported, even to groups [CTRL], from left side “Explorer”.  

By clicking on  , the  icon highlights all files in order for the whole 

folder to be imported. Moreover you can rapidly access Desktop folder and Documents by 

clicking on the corresponding keys.  

You can still import songs in Winlive’s classical way via  

 

 

 

In both cases, the final import window will open up and you will be able to set : 

 song list destination; 

 Files’ path (if file was not selected from “Explorer”); 

A secondary folder where to save copies of imported files, with a possibility of moving 

them in another folder; 

 Muted channels for Midi files;  

 Complete Import (slower) or Fast; 

 Title of scanning or using name as title 

 File won’t be transferred to database of it already exists. 

 

By   key you can abort import, whereas  allows you to import files in background. 
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NB: fast import realizes process in an extremely quick way but it does not deep checks files’ integrity or Mp3 

tags. 

However, files which will be considered invalid, like Midi with chopped notes or missing 

important information won’t be imported no to compromise the performance of the singer. 

 

Warning: integrity checks won’t be carried out on files from Song Folder Lists and on the spot files, therefore 

semi-damaged files could suddenly open and create unforeseen errors, stuck notes, lyrics view problems, 

etc…. 

 

-Database icons 

 

Respectively, deselect all, select all, hide selected, show 

only selected 

 

Set filters based on type of file and/or belonging Song List 

 

In order: Back to Performance mode, Open a database, 

Save a database, New database, import from previous 

version , find and show clones, Backup, restore previous 

Backup, Edit Database. 

 
Move song or selection to another list  

 
Open Import Song window 

 
Erase song or selection from database 

 
Erase all songs from grid (depending on filters) 

 
Use file name as title for song or selection 

 
Look for title among current songs in grid  

 
Copy file to another path 

 

Open window to search or remove file 

Missing/moved/deleted 

 
Open Song List Manager 

 
Substitute path or file name 

 
Create HTML format database report 

 
Create Excel format report of database  

 

Suggestions: if you stay on an icon, you will get a description label. 
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Missing Files 

 

Missing Files research allows you to scan the whole database to find files which you 

cannot find on your hard disk anymore because they could have been deleted or moved to 

another folder. 

To find Missing Files, click on “Control”. Once scanning ends, you can erase the 

corresponding file from database or insert a new file path (in case they were moved), by 

specifying new folder. 

Replacing file path or name 

 

This functionality allows you to substitute parts of a file or a file selection’s path.  
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Media Explorer 

In Media Explorer you can play songs directly from your hard disk, apply display filters and 

import them in Winlive 7’s database. 

 

you can play songs on the spot by simply double clicking on the song itself or by pressing 

Enter. 

By clicking on Default >>> you can open some default paths. Open Window allows you to 

locate song on hard disk through Windows’ Explorer. 

 

 Exported Songs: physically saved Midi songs’ default destination folder; 

 Siae: Siae lists’ default destination folder; 

 Store: you can import all lyrics which were not synchronized with Winlive’s previous 

versions in this folder; 

 User: default destination folder for User sounds created with Mixer sound Editor. 

 Favorites: “+” and  “x”  allow respectively to add or delete favorite paths.; 

 Subfolders Scan: scans all subfolders; 

  search for line: respectively reduce and enlarge font size; 

 ADD to F10 : adds songs to F10 list; 

 Import: imports in database; 

 Book: books song. 

Warning: the Virtual Folders window allows, if active, to open folders into virtual paths from Windows 

Vista* and Windows 7. 
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Spuntare se si utilizzano queste versioni di Windows. 

 

* Per alcune versioni di Windows Vista, oppure se è stata disabilitata manualmente la funzionalità UAC del sistema operativo non 

occorre spuntare questa casella. 

 

Youtube Video Songs 

New function introduced with Winlive 7 and accessible through the Youtube button 

collocated at the bottom left in Performance mode or via View -> Youtube songs. 

 

As you can see in the picture, this allows you to search for and view backing tracks directly 

from Youtube by searching by title and artist. 

A search filter is already set for karaoke backing tracks, other than viewing them, you can 

also import them to a song list from database and insert title, artist, author, key. 

Warning: you can neither edit nor download tracks, you can only import link into database 

and view track only with an active internet connection. 

 

Metrodrummer  

Metronome with rhythmic patterns, accessible via View -> MetroDrummer or via the MDR key, at the right 

side of your screen in Performance mode. 



 42

 

This function allows you to edit drums patterns in midi files, you only need to select your favorite rhythms and 

click on Style Synchro while your backing track is playing and it will automatically get synchronized with 

drums in MetroDrummer.  

Metrodrummer can also be used to play drums patterns only, allowing you to vary tempo (BPM), insert 

variations, percussions, insert an intro and an outro. 

It can also be used as a metronome 4/4, 3/4, 2/4, 5/4, 6/4, 7/4, 9/4. 

Winlive DJ Control  

Simplified section for DJs, accessible via View -> Winlive DJ Control or through WDJ key in Performance 

mode. 

 

Winlive DJ mode with BPM recognition for Audio files with real time effects, it allows you to make both 

manual and automatic mixes.  

To perform Automatic Mix while playing your first track and having booked your second one, you only need 

to click on Tempo Sync and then on Auto Mix, this way Winlive DJ will switch to the next track automatically. 

To perform manual Mixing instead, still while playing your first track and keeping your second one booked, 

you just need to click on Tempo Sync and then on Manual Mix, in  this case you will find a red sign saying 

Mix 2%, you will need to click many times on manual mix to increase mixing percentage and gradually pass 

from one track to another. 

Other than various mixings, Winlive DJ also allows you to insert effects like Reverse Play, auto WHA and 

Phaser, which you can also use through the pad on the keyboard. 
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Background Songs 

This newly inserted function, which you can find in Winlive pro 7, will allow you to create an audio files list to 

use as background playlist. 

 

By clicking on Add Song, you will be able to add audio files to the song list, load playlist allows you to load an 

already saved playlist, save playlist allows you to save a just loaded list, it eliminates all the songs you are 

viewing, A/a shrinks font whereas a/A enlarges it and at last random allows shuffle playing. 

This function also allows you to regulate volume and fade IN and fade OUT. 

Karaoke Monitor Subtitles 

 

This setting allows you to insert subtitles on karaoke monitor, letting you customize color, font, background, 

size and speed. 
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Speed dial keys 

Here’s a list of keys (shortcuts) and their related functions: 

Performance Mode (Song List off): 

 
Space bar Opens Song List or Pauses/Plays Song   

 
Arrow Keys   Open relative Song List   

 
F1, F2, ..., F10  Open relative Song List   

 
Shift + [F1 .. F10]   Open relative Song List   

 
Ctrl + [F1 .. F10]  Open relative Song List   

 
Shift +Ctrl + [F1 .. F10]   Open relative Song List   

 
1..2..3…..0 Plays relative cue point or muted channel 

 
Shift + [1..0] Books relative cue point   

 
Ctrl + [1..0] Books relative cue point to booked song   

 
Shift + Ctrl + [1..0] Skips to relative cue point to booked song   

 
O Plays song from the start   

 
Q Fade out on booked song 

 
W  Changes karaoke font size (Small Medium Large)   

 
F Forward 

  

 
R  Back  

 
M Melody (ch. 4) Yes/No [Midi Song]   

 
T Restores original tempo [Midi Song] 

 
U Melody only (ch. 4) [Midi Song]   

 
N on/off channel as original 

 
P Talk over (on pressed key)   

 
A Activates all channels [Midi Songs]   

 
K , L Lyrics Scrolling on musicstand   

 
D Drums only (ch. 10) [Midi Song]   

 
C Views/Hides chords 

 
Y Mixes with booked song   

 
X Starts Mixer   

 
V Vocalist track (ch 16) yes/no [Midi Song]   

 
B Bass only (ch.2) and drums (ch. 10) [Midi Song]   

 
Enter Plays booked song   

 
Pause  Pauses/Plays 
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+ Adds a halftone  

 
- Goes down by a halftone 

 
Pg. Up  Increases Tempo [Midi Song]   

 
Pg. Down  Decreases Tempo [Midi Song]   

 
Ctrl + + Increases by a halftone on booked song [Midi Song]   

 
Ctrl + - Decreases by a halftone on booked song [Midi Song]   

 
Ctrl + Pg. Up  Increases Tempo on booked song [Midi Song]   

 
Ctrl + Pg. Down  Decreases Tempo on booked song [Midi Song]   

 
Ctrl + M Booked song Melody (ch. 4) yes/No [Midi Song]   

 
End Downloads booked song (STOP) 

  

 
Z  Fullscreen mode 

 
Backspace Opens search box in song list   

 
Tab Scrolls in search occurence in song list 

 
S  Audio Sampler   

 
J  Preview   

 
E Displays/Hides Melody Bar   

 
Ctrl + Q  Virtually saves current  song 

 
Ctrl + K  Enables/Disables Karaoke Monitor   
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Performance Mode (Song List on):  

 
Start First column of song list   

 
End Last column of Song List   

 
Initial Look for first song by initial   

 
Space bar Books song and closes Song List   

 
Ins Inserts song in temporary song List (F10)   

 
Pg. Up  First line of Song List   

 
Pg. Down  Last line of Song List   

 
Backspace  Looks for a Song   

 
Tab  Repeats search   

 
Enter Plays Song and closes Song List   

 
Esc  Closes Song List   

  
 

 
 
Preview 

 
Esc  Closes without saving   

 
F  Forward  

 
R  Back   

 
G Closes and saves previous position   

 
J Sets position without closing preview 

 
H Tests position without closing preview   

 
O Start  

 
ENTER Closes by saving current position   

 
 
Audio Sampler  

 

 
\    Stops all samplers 

 
S    Opens / Closes and stops all samples 

 
1..2..3…..0   Plays Sample   

 
Ctrl + 1..2..3…..0   Selects set    
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Suggestions:  

1) Winlive is structured so that users can manage most of its functions in Performance Mode, while they are 

live, via the only usage of the computer’s keyboard, therefore avoiding having to use the mouse, which 

requires more time and artist’s deconcentration. 

2) It is advised to keep a printed sheet of the shortcuts near you, generally after a few performances, users 

tend to memorize keys and managing the software gets even simpler and immediate. 

 

 

Options 

Winlive Pro 7 gives users the possibility to customize their working desktop by regulating 

parameters and options . 

You can access options via Tools -> Options. 

 

Suggestions:  

1) You can always come back to default options by choosing RESET; even the two paths from 

SongFolderList will be erased; 

2) If your computer is old, you can speed up the execution of Winlive by clicking on “USE SETTINGS FOR 

MINIMUM REQUIREMENTS. This way options oriented towards speed rather than graphic quality will be 

applied.  
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Options’ Entries 

 

General Options: 

 

 

Stop at the end of every song 

Disables booking of the next song on the list. 

 

Stops song even if booked 

Disables song’s reproduction even if booked. 
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Shuffle next song 

Shuffle books next song. 

 

Disables automatic start of the song 

Every required song does not start automatically 

 

Scrolling Melody Bar 

The melody bar, which you can activate via CTRL+E, can be steady or can be set on 

power operated sliding. 

 

Display cue points on Melody  bar 

As description. 

 

Use indicating dials on Melody  bar and notation  

During power operated sliding of the Melody bar, it is possible to get a progressive 

measurement numbering. 

 

Top or bottom Melody bar 

Melody bar position during performance. 

 

Vertical, steady horizontal, horizontal with height Melody indicating dials 

As description. 

 

Melody Bar on main monitor only, on karaoke monitor only, on both 

As description 

 

Automatic Mixing  

Between a song and the next one or the booked one, audio only, audio and midi, inactive.  

Milliseconds on waiting before starting the song 

Set number of milliseconds the software has to wait before playing the song. 

 

Volume Talkover 

By pressing “P” during performance volume will go down to the chosen percentage, letting 

artist talk while the song is playing. 
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1,2,…,0 Keys 

You can use number keys to quickly access cue points or mute tracks from 1 to 10.  

Use Space bar to 

You can use space bar to play or pause a song or to display or hide a song List. 

 

USE “ESC twice” to Stop rather than ESC 

If checked off, stop will be enabled by pressing ESC twice rather than once. 

See clock 

Displays clock at top right. 

 

Open Melody bar at the start 

Melody bar opens whenever the software starts. 

 

 

Open Chord bar at the start 

Chord bar opens whenever the software starts. 

Use sharp contrast indications 

As description. 

 

Do not use led 

Leds are positioned and are active corresponding to the various instruments which you 

can see in Mixer interface; by checking this box off, they get disabled.  

Do not use VU-Meter for midis 

Vu-Meter is active in Mixer interface to signal sound level and can be deactivated by 

checking off its corresponding box. 

 

End-of-the-song flashing CountDown 

Countdown is available at the top middle of the performance screen and starts flashing 

some seconds before the end of the playing song; by unchecking its specific box, it is 

possible to cancel it.  
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Automatically hide Tablet keyboard 

By checking off the corresponding box, the keyboard can be hidden or moved to your 

favorite position by choosing it from a relative drop down menu.  

 

Tablet keyboard position 

Allows you to decide where to move the keyboard. 

 

Language 

Choose favorite Language 

 

ADVANCED SETTINGS   (It is advised not to vary default settings if you are not an 

advanced user)  

 

Double Buffer screen 

It uses a double Buffer on a graphic level to reduce flickers and better graphic quality. (It 

could be necessary to restart Winlive to make changes effective.) 

Use this on a computer with a good graphics card only. 

Check for updates at the start 

if checked off, it allows you to automatically check for updates at every start. 

Disable style in menu 

If not checked off, drop down menus are stylized. 

Interface Update 

Graphics Interface will be updated every bunch of milliseconds. 

Midi 1 Option: 
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Midi device 

You can set both a physical (expander, Keyboard) or a virtual (roland VSC, Microsoft 

Softsynth) device for Midi. 

Refresh key updates list if a new device has just been linked. 

 

Out 

Preset output for Midi. 

Start from first note 

If checked off, it allows you to get positioned on the first useful note when opening the Midi 

file, allowing therefore immediate access. 

Stop on last NOTE-OFF 

If checked off, it allows you to end song on the last, trimming a possible tail of the sound.  

Midi tracks Vol% (1-100) 

It allows you to vary general volume on midi tracks in percentage.  

Midifile compression 

It enables compression of dynamics of the notes from Midifile according already set min 

and max values.  
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Metronome Device 

You can set a different device as metronome, or use the same main device. 

Warning:  using a different device could cause problems with timing, due to the different latencies of  the 

used midi device.  

Initial Measurements with a metronome 

A metronome will be played until the chosen number of beats the nit gets automatically 

turned off. (It is convenient to use this function alongside with start on first note 

deselection). 

 

Metronome sounds 

This side of the menu will allow you to edit the sound of the metronome and set its volume. 

 

Midi input 

It allows you to link a keyboard or any other device which puts a Midi flow in Winlive.  

Ignore Midi track reading  

It ignores the reading of different parameters from note on and note off on selected track 

for midi files, it is disabled if set on off. 

It regulates touch sensibility on midi input assigned keyboard. 

Midi 2 options: 
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Risolution Timer 

Midi messages are sent in blocks every bunch of milliseconds. 10 milliseconds is usually 

the best resolution. 

An increase of the timer decreases CPU load and may clog your Midi device, decreasing it 

instead distributes midi messages but could weigh on slow CPUs. 

The default working range within which tempo is kind of precise usually varies from 5 to 30 

milliseconds. 

Midi Engine Multitasking 

Midi engine multitasking allows to perform more midi flows at the same time, by increasing 

load and performance speed, brilliant for good performances computers.  

Filter Non GM-GS text messages 

It leaves out redundant midi events which are considered useless for Midi File 

reproduction like Control Change etc…  

Some devices which have advanced functions like Karaoke or Vocalist ouput could be in 

need of these kind of messages in combination with some spcific backing tracks. Deselect 

it only if you have this kind of problems. 

Light Load 

It leaves out some midi events like Pitch-bend, AfterTouch, etc… 

Enable it only if you have slowdowns during midi files reproduction.  

 

Send Reset Sysex before song 

It send a standard reset Sysex message before each midi song, the kind of reset message 

(i.e. GM, GS, etc…) can be chosen from the drop-down menu just below. 

Partial Note OFF 

An alternative mode to use reset when changing key, pausing or at the end of a track. 

Do not enable it if you are using an Expander or notes will lapse very slowly. 

Program Changes start from 1 

By convention, the displayed program changes can start from 1 rather than from 0 (only by 

visual indication). 

M-live Drums compatibility 
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Leave out some drums kits which can block M-live xlight and M-live Xlight 2, do not select 

if using different midi devices from the just listed ones. 

Ignore standard reset sysex messages already included in midi file. 

Send SysEx messages 

It enables sending SysEx messages contained in midi-file during reproduction.  

Example:  if the song contains 2 drums tracks, enabling it is necessary so that its corresponding SysEx 

message which indicates that track 9 or 11 is drums can be read. 

 

Send SysEx Messages before start 

It sends a series of SysEx controls before the start of every song. It is very useful for old 

Expanders which utilize non-standard instructions. 

 

Example:  to send GM reset, disable the “send GS reset” option then paste the following line onto “send 

SysEx messages before start”: 

F0 7E 7F 09 01 F7 

 

For XG reset, paste the following line: 

F0 43 10 4C 00 00 7E 00 F7 

It is possible to choose whether to address SysEx messages only towards the main Midi 

device or towards all devices. 

Flow optimization 

It optimizes data flow during midi reproduction, it is advised not to disable it. 

 

Time control sysex 

Set delay time after sending a sysex message to the device. 

Allow multiple midi ouputs 

It allows using several midi outputs.
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Audio options: 

 

 

Audio device 

 

It is possible to set an output audio device (Audio and video), typically a sound card.  

The Refresh key updates the list if a new device has just been linked. 

Use secondary device. (Pre-listening) 

You can set a second device for you to use the pre-listening functionality, usually a sound 

card. 

Second audio output device 

It is possible to set a second audio output. 

FF Jump 

It indicates the seconds you skip when you choose FastForward on an audio backing 

track.  key ('F'). 
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Cut silence at the beginning 

If checked off, it allows performing audio files directly from the first audible part. It is useful 

to check it off if you wish for an immediate performance even for audio tracks, especially 

for CDG which often contain a silent part at the beginning which can last up to 10 seconds. 

 

Quick loading 

It enables loading on the spot, even faster on audio files.  

Speed increase is not that evident since Winlive is already very fast. It is advised to enable 

this option only if playing backing tracks in a very real-time way is really needed as this 

could reduce the transpose quality on some sound cards.  

Pre-Load Audio 

If checked off, this option allows to load in storage the audio track right when booking it, for 

it to start more quickly.  

 

MultiTask preload 

If checked off, this option allows to fasten backing tracks’ loadings. 

Tempo change without distortion  

It allows to change tempo without backing track to be distorted. 

 

Volumes’ compression  

It enables the compression of the volumes on audio tracks, for details go on Tools 

Winlive audio options.  

Enable Gain 

It enables using gain in virtual mixer. 

 

Audio Buffer 

It sets buffer dimension. Only increase this parameter if you hear interruptions while 

playing audio and video files. It is not advised to decrease value under pre-set one. 

 

Smooth IN 

It sets possible steady fade IN for audio tracks (time expressed in milliseconds).  

 

Smooth OUT 

It sets a possible  steady fade OUT for audio files (time expressed in milliseconds). 
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Chords and Lyrics: 

 

 

Chords notation 

It allows to leave notation unchanged or to convert all chords contained in the files to 

italian or english format. 

Leave Out Bass Rivolto 

If active, display chords leaving out ….., if present. 

Example: Gsus/C will be displayed as Gsus 

  

Transpose chords based on transpose 

If enabled, chords’ transpose follows key change on backing track (audio or midi). If 

disabled, it leaves chords unchanged when key change is carried out. 

Read CC#1 Format, GENERALMUSIC 

It allows the reading of the chords in specific formats. By enabling this option, it is possible 

that different information from chords could be read in chords field. 

Chord Bar 

It allows to set the height of the chord bar. 

Power-operated sliding of the Chord Bar  

It allows chord bar to slide alongside with the backing track. 
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Number of cells in the chord bar  

It allows to choose the number of the cells into the chord bar. 

 

Chords in melody bar 

It allows you to insert chords in melody bar. 
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Colors 

You can vary the color of the chords on the lyrics (“Music stand with Chords” mode), that is 

useful to differentiate the Karaoke lyrics from the chords. 

  

Display Txt and Rtf even in Karaoke Monitor 

If checked off, this allows to view the lyrics even in karaoke Monitor. 

 

Font TXT 

It allows to edit font, color and size of the text within background. 

Karaoke and images: 

 

 

From this window, you can change the graphical theme of the program, the wallpaper and 

you can also customize the colors of the lyrics and the background other than the font of 

the Karaoke.  

Theme 

It allows you to select a graphical theme for Winlive. The theme affects background and 

color of the lyrics, filling, shadows or effects.  
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Background color 

Select a color with a double click or choose a customized one from […] 

Warning: some combinations of themes and colors can make Karaoke lyrics difficult to read when 

background is disabled.  

Use background picture 

If checked off, it matches a default background picture with a theme for all performances. 

 

Monitor’s background  

PIt allows to customize the wallpaper of both main monitor and the Karaoke monitor.  

 

Karaoke Mode 

 Modern Style – lyrics on 4 lines 

 Reading Mode – lyrics on 2 lines 

 Music stand with chords – lyrics on 2 pages/8 lines 

 No Karaoke  

 

Style 

You can choose to display lyrics with a border, a shadow or without  any graphic effect 

(useful for older computers).  

 

Bouncing Ball Indicator 

It helps you visualize an animation on a line or a syllable on the Karaoke lyrics while 

sliding. Colors can change on midi files, following the beat of the metronome. 

 

Advance – delay on lyrics 

You can anticipate or postpone by a chosen number of milliseconds the sliding of hte lyrics 

respect to how set  in Midi File or Mp3 files. 

M-live encoding priority rather than Karaoke 

There are midi backing tracks which can have more than an encoding for lyrics/chords, for 

example sysex format and tune 1000 format. By default, priority is assigned to sysex lyrics. 

If you encounter lyrics missings or malfunctions, deselect this function.  

Allow lyrics and chords synchro in wave files  
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CDG / Video (advanced users only) 

 

 

It is advised to only interact with these parameters if you are fully aware of the structure 

and characteristics of Mp3+CDG (graphic Karaoke) files.  

Personal background on CDG  

If enabled, use current background color instead of the original CDG background color. 

 

Use border on CDG 

Enable border coloring on CDG where available. 

Disabling it, by default, allows an improvement on CDG reproduction on a computer since 

they do not need a border like on a TV.  

 

Bias-Color  

It is possible to regulate the RGB color range (red, green, blue), higher values determine a 

higher lightness for the corresponding color range. 

 

Video Files 

 

Video files on karaoke monitor only 
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Your video file will only be loaded on the Karaoke monitor, whereas the lyrics will appear 

on the main monitor. 

 

Do not use video on Karaoke monitor  

By enabling this function, the video won’t be displayed on the Karaoke monitor and the 

loading time will decrease.  

Keep proportions 

Keep video dimensions the same as original video.  

 

Associated loop video 

… 

 

Use video rendering from winlive 5.5 

Using this function allows the reproduction on less performing computers by decreasing 

loading time. 
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Song List: 

 

 

Song List Order Type 

It is possible to choose the type of order for the song lists.  

ID = inclusion order, the last inserted songs will play at the end 

TITLE = by title, AUTHOR = by author, INTERPRETER = by interpreter. 

You can select the kind of order for the song lists even by combining different fields. 

You can use the field Order, which allows you to create a customized order as defined in 

database (last field). 

 

Song list cells 

It allows you to set the size of the cells. By setting 2 cells on each line, you can obtain 

bigger dimension for the cells. 

 

Song list columns 

It allows you to set the number of columns to display in the song list.  

Font/ song list cell size  

It allows you to set font size in the cells on every song list.  
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Number of characters per cell 

You can use it to set the number of maximum characters which  every single cell should 

have. It is advised not to modify this option.  

 

Song List Position  

You can visualize the song list at the bottom or at left side.  

Interpreter at title right 

It allows you to choose where to collocate the singer of a track.  

Dialling in song list 

It allows you to make a quick search via keyboard by allowing you to choose to search by 

first letter, smart search at the start and smart search on the whole name.  

Grid style 

It allows you to regulate the border of the cells on all song lists.  

 

Lyrics style 

It allows you regulate the evidence of the text in the song lists.  

 

Song List in Karaoke Monitor 

It allows you to view the song list even on the second monitor.  

 

SongList Colors 

It allows variation of the colors viewed into the song list by assigning a different color to 

each kind of file, other than for the background and the selection. 

 

Song list font 

It allows you to regulate characters in the song list.  

 

 

Color played song 

It colors all the already performed songs.  

Song list’s pre-load 

It pre-loads songs and increases speed. 

Do not hide Song List at the end of a song 
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Point out song with Karaoke/Chords “K”  

It points out the presence of lyrics or chords through the letter K 

 

Operations on the options 

 YOU NEED TO CLICK ON “APPLY” TO APPLY OPTIONS  

 CLICK ON “RESET” TO RESET DEFAULT OPTIONS 

 CLICK ON “CANCEL” TO LEAVE WINDOW AND DISCARD EDITS 
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ADDENDUM 

Specifications and compatibility 

Function Carachteristics 

Files compatibility: 
MIDI, KAR, MP3, CDG, WAV, MPG, AVI, TXT, FLV, 

MP4, YTB 

Midi format compatibility: Type 0, Type 1, Smf 16 tracks 

Lyrics Compatibility: Tune1000, M-live, Solton, TextInKar, MP3TagV2, MP3 M-liveText 

Reset mode: 
GS, it assures full compatibility with the best part of midi backing 

tracks  

Max. number of songs in list: 50.000 

Max. number of songs in database:  > 200.000 

Average access time per song: 0.05 - 0.2 secs. Calculated on 2Gzh, 2GB ram 

Number of pre-set sounds: 128 Instruments* + 10 DrumKits* + 32 User Sounds 

 

The midi engine was reprojected all over again respect to the older versions of Winlive 

therefore you could notice some small differences during reproduction.  

Now the management of midi files happens in MultiTasking in an independent process so 

it is possible to open windows while continuing to work or to open other programs and 

iconify Winlive even while performing a Midi file without encountering slowdowns and midi 

tempo losses.  

*In reality, the midi sounds which can be used are even more but by convention, you always see the name of the first desk on the sent program 

(i.g. for Hard FM Piano bank024-pc:006 the name ELECTRIC PIANO 2 bank:000-pc006 will be visualized) but if the device is enabled to play 

such sound, it will use the correct sound.  
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Legal Notes 

Licensing Agreement Winlive Pro 7 
 
CAREFULLY READ THIS FILE BEFORE OPENING PACKAGE.  
THE PROGRAM CONTAINED IN THIS CD-ROM IS LICENSED TO THE USER. BY OPENING THIS 
PACKAGE, YOU AGREE TO TERMS AND CONDITIONS FROM THIS LICENSING AGREEMENT. 
WARNING: THIS PROGRAM IS PROTECTED FROM COPYRIGHTS LAWS AND INTERNATIONAL 
TRAITS. THIS SOFTWARE IS LICENSED BUT IT IS NOT SOLD.  THE UNAUTHORIZED 
REPRODUCTION OR THE DISTRIBUTION OF THIS PROGRAM, OR PARTS OF IT, CAN LEAD TO 
CRIMINAL AND CIVIL SANCTIONS. 
1 – User’s rights 
 
PRO MUSIC SOFTWARE grants the final user to have the right to use a copy of the attached software on a 
singular computer. The software is considered “in usage” on a computer when it is loaded on a temporary 
storage (RAM) or installed on a permanent storage (i.g. hard disk, CD ROM or another storage device) on 
that computer.  
 
2 - Copyright 
 
This Software belongs to PRO MUSIC SOFTWARE and is protected by the copyright laws applicable in Italy; 
by dispositions and international traits and by all other applicable national laws. The user cannot reproduce 
the help guide or parts of it and other material which comes with the software.  
3 – Guarantee limits 
  
PRO MUSIC SOFTWARE grants that the Software will work as described in the help guide. For the 
protection of the users, it will be possible to request a new activation (for a total of max. 4) in case of 
computer change after uninstalling the program from the prior one or in case of theft, loss or formatting of the 
computer. 
4 – Responsibility limits 
 
In no case PRO MUSIC SOFTWARE can be considered responsible for any damage (included without 
limitations: damage for loss of income, interruption of the activity, loss of information, sanction or other 
economic losses) coming from the usage or inability to use the software, even if PRO MUSIC SOFTWARE 
was warned of the possibility of such damages.  
 
5 - Installation 
 
Winlive Pro uses an auto-installing installation package 
 
At the moment of installation, you will be able to choose the installation path and other parameters. Notice 
that register entries and system settings could be edited in order to allow the perfect working of the program 
itself.  
 
6 – Other restrictions 
 
The Setup in this Pro version is redeployable just as it is. It is forbidden reproducing or distributing even 
partially files generated from the Setup. 
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Credits and thanks 

Special thanks to Pro Music Software for the resources and the offered courtesy. 

A particular thanksgiving goes to all the BetaTesters and to whoever worked on our forum 

in order to make the program more and more in line with the current standards, bestowing 

advice to make the program more and more efficient and pleasant. 

 

Ideator: Leonardo di Pinto  

Author and Programmer: Pinto Giuseppe Massimo 

Consultant programmer: Leonardo Cosmai 

Graphics: Monti Francesco, Lampedecchia Massimo  

Expert witness: Nicola di Liddo 

Expert witness: Valente Alessandro 

Expert witness: Muti Domenico 

Expert witness: Di San Leonardo Gaetano  

External consultants: Rotella Mario, Dimarti Eber, Geusa Eugenio Massimo, Frassati 

Angelo, Grimaldi Massimo, Vernucci Massimo, Viaggi Armando, Caselli Domenico, De 

Iudicibus Mauro, Scarpelli Primo, Boemio Giuseppe, Conforti Mauro, Zucaro Roberto, 

Spadari Graziano, Chiaiese Vincenzo 

 

Produced by ProMusicSoftware 

 

www.promusicsoftware.com 

info@promusicsoftware.com 

Via Perlasca 8, 76011 Bisceglie (BT) 

Via Sant'Andrea 152, 76011 Bisceglie (BT) 

This help guide is in line with the Winlive Pro 7.0 version, we are not responsible for any omissions or incoherence since frequently 

released micro-updates can vary the specifications of the product. 
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